EASY MOBILE

User Guiade




Table of Contents

Getting Started 11
Introduction 111
Requirements 1.1.2
Using Easy Mobile 1.1.3

Advertising 1.2
Module Configuration 1.21

Setup Ad Networks 1.2.1.1
AdColony 1.2.1.1.1

AdMob 1.21.1.2
Chartboost 1.2.1.1.3

Heyzap 12114

Unity Ads 1.21.1.5
Automatic Ad Loading 1.21.2
Default Ad Networks 1.21.3
Scripting 1.2.2
PlayMaker Actions 1.2.3

Game Services 1.3

Module Configuration 1.3.1
Android-Specific Setup 1.3.11
Auto Initialization 1.3.1.2
Leaderboards & Achievements 1.3.1.3
Constants Generation 1.3.1.4
Saved Games 1.3.1.5

Scripting 1.3.2
Saved Games 1.3.21

PlayMaker Actions 1.3.3

GIF 1.4
Setup 141
Scripting 142
PlayMaker Actions 143

In-App Purchasing 1.5
Module Configuration 1.5.1

Enable Unity IAP 1.5.1.1
Target Android Store 1.5.1.2
Receipt Validation 1.5.1.3
Product Management 1514
Constants Generation 1.5.1.5



Scripting

PlayMaker Actions
Sharing

Scripting

PlayMaker Actions
Native APIs

Native Ul

Scripting
PlayMaker Actions

Notifications

Module Configuration
Auto Initialization
Remote Notification Setup
Adding Notification Resources
Category Management

Constants Generation

Scripting
PlayMaker Actions
Utilities
Store Review
Configuration
Scripting
PlayMaker Actions
Release Notes [Basic]
Release Notes [Pro]

Upgrade Guide

1.5.2
1.5.3
1.6
1.6.1
1.6.2
1.7
1.7.1
1.7.11
1.7.2
1.8
1.81
1.8.1.1
1.8.1.2
1.8.1.3
1.8.14
1.8.1.5
1.8.2
1.8.3
1.9
1.9.1
1.9.1.1
1.9.1.2
1.9.2
1.10

1.12



Easy Mobile User Guide

This document is the official user guide for Easy Mobile, a Unity plugin family by SgLib Games.

Easy Mobile Versions

e Easy Mobile Pro
e Easy Mobile Basic (coming soon)
e Easy Mobile Lite (Free)

Important Links

e Online Documentation
e Support Email

e Forum

Connect with SgLib Games

Unity Asset Store

Facebook

Twitter
YouTube

Document Usage Notes

e This document is the official user guide for all Easy Mobile versions (Pro, Basic and Lite)

e The whole document is relevant to the Pro version

e All chapters are relevant to the Basic version, except those relating to Pro-only features, which should be marked
accordingly

e The following chapters are relevant to the Lite version, users of this version can safely ignore other chapters:

o Sharing

o Native APIs > Native Ul


http://u3d.as/Dd2
http://u3d.as/184q
http://u3d.as/FN0
https://sglibgames.gitbooks.io/easy-mobile-user-guide/content/
mailto:support@sglibgames.com?Subject=[YOUR_INVOICE_NUMBER]
https://forum.unity3d.com/threads/easy-mobile-many-in-one-package-for-mobile-games.453496/
https://www.assetstore.unity3d.com/en/#!/search/page=1/sortby=popularity/query=publisher:20993
https://www.facebook.com/sglibgames
https://twitter.com/SglibGames
https://www.youtube.com/channel/UCfNiWpkrQsoXDAMBrjhV9GQ

Introduction

Easy Mobile is our attempt to create a many-in-one Unity package that greatly simplifies the implementation of de
facto standard features of mobile games including advertising, in-app purchasing, game services, notifications and
native mobile functionalities. It does so by providing a friendly editor for setting up and managing things, and a cross-
platform API which allows you to accomplish most tasks with only one line of code. It also leverages official plugins
wherever possible, e.g. Google Play Games plugin for Unity, to ensure reliability and compatibility without reinventing
the wheel.

Easy Mobile supports two major mobile platforms: iOS and Android.

This plugin is currently divided into the following modules:

« Advertising

o Compatible with AdColony, AdMob, Chartboost, Heyzap and Unity Ads; even more with AdMob or Heyzap
mediation

o Automatic ad loading
o Allows using multiple ad networks in one game

o Allows different ad configurations for different platforms

Game Services

o Leverages Unity's GameCenterPlatform on iOS and Google Play Games plugin on Android
o Leaderboards and achievements

o Saved Games (Pro version only)

GIF (Pro version only)

o Records screen, plays recorded clips and exports GIF images
o High-performance, mobile-friendly GIF encoder

o Giphy upload API for sharing GIF to social networks

In-App Purchasing

o Leverages Unity In-App Purchasing service
o Custom editor for easy management of product catalog

o Receipt validation

Sharing

o Shares texts, URLs and images using the native sharing functionality

Native APIs

o Access to mobile native Ul elements including alerts and (Android) toasts


https://github.com/playgameservices/play-games-plugin-for-unity

o More native functionalities will be added soon

« Notifications

o Fully-customizable local notifications
o Compatible with OneSignal and Firebase Cloud Messaging, free and popular services for push notifications

o Supports notification channels and channel groups on Android O and higher

« Utilities
o Store Review: provides an effective way to ask for reviews and ratings using the system-provided rating

prompt of iOS (10.3+) and a native, highly customizable popup on Android

The modular approach allows you to enable only the modules that you use, which helps avoid redundancies

and potential conflicts with existing code that does the same job in your project, if any.

Easy Mobile Versions

Easy Mobile comes in 2 different versions: Basic and Pro. Easy Mobile Basic is the lower-price version which contains
most of the core features of the plugin, except a few advanced functionalities such as GIF and Saved Games. The Pro
version is the premium one and have all features available. This document is shared between both versions, and Pro-

only features will be marked accordingly in the corresponding chapters.

Below is a feature-comparison table of the Basic and Pro versions of Easy Mobile.


https://onesignal.com/
https://firebase.google.com/docs/cloud-messaging/
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FEATURES

Advertising

Compatible with AdColony, AdMob, Chartboost, Heyzap & UnityAds = o
‘more networks can be used via AdMob or Heyzap mediation

Multiple ad formats: banner, interstitial, rewarded [ ] ]
One unified API for all ad networks ' .
Automatic ad loading * [ ]
Showing ads from multiple networks in one app ' ]
Built-in Remove-Ads function (] .

‘Game Services :

Compatible with Game Center (iOS) & Play Game Services (Android) .
Automatic leginfinitialization .
Leaderboards L]

°

Achievements

Saved Games
»  Using iCloud (i0S) and Google Drive (Android)
*  With autormatic conflict resolution

GIF )

Low-overhead screen recorder

Built-in players for recorded clip playback

Mobile-friendly GIF encoder

Full contrel on GIF generation: sizes, length, guality, frame-rate, etc.

Advanced color quantization for high guality GIF images

Giphy upload API

In-App Purchasing

Multiple stores supported: App Store, Google Play, Amazon Apps, etc.

Multiple product types: consumable, non-consumable, subscription
Custom editor for easy management of product catalog

Auto initialization

Local receipt validation

Native APIs

MNative Ul
* Alerts (one, two and three buttons popups)
* Toasts (Android only)

Notifications

ﬂoHoooolHooolooﬂoocoo

Fully-customizable local notifications
Android 8.0 notification channel & channel group support
Push notifications (compatible with OneSignal)

...“OH...'.I

a
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Sharing
Sharing of images, texts and URLs via native sharing functionality ] ]
Built-in screenshot capturing methods . [ ]
Utilities
Store Review
*+ System-provided rating prompt (iOS 10.3 and higher) '] ]

* Custom native rating popup (Android, iOS lower than 10.3)

Visual Scripting Support

Compatible with Playmaker (100+ custom actions) L]
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Requirements

e Unity 5.3.0 or above.



Using Easy Mobile

Using Easy Mobile involves 3 steps:

e Configure the plugin using the built-in Settings interface
e Make sure an instance of the EasyMobile prefab is added to your first scene
e Make appropriate API calls from script

Configuration

After importing Easy Mobile, there will be a new menu added at Window > Easy Mobile from which you can access
the Settings interface and configure various modules of the plugin.

Store Tools mm Help a g | = o) 100% 0

Der  Minimize €M id <OpenGL 4.1
Zoom

Bring All to Front
Google Play Games

Layouts
Easy Mobile

L] Inspector

reate EasyMobile.prefab
Documentation

Services 80
Scene 281
Game 262
Inspector 23
Hierarchy 564
Project ®5
Animation 5]
Profiler 367
Audio Mixer 368
Asset Store k9
Version Control

Animator

Animator Parameter

Sprite Packer
Editor Tests Runner

'ERTISING

1y Advertising modu
= range of ad netwe

HASING

Lighting
QOcclusion Culling
Frame Debugger
Mavigation

IILE Ul

Console

The Settings interface is the only place you go to configure the plugin. Here you can enable or disable modules,
provide ads credentials, add leaderboards, create a product catalog, etc.



Using Easy Mobile

All these settings are stored in the EM_Settings object, which is a ScriptableObject created automatically after
importing the plugin and is located at Assets/EasyMobile/Resources. You can also access this EM_Settings class

from script and via its properties accessing each module settings in runtime.

EasyMobile Prefab

For the plugin to function properly it is required that an instance of the EasyMobile prefab is added to one of the game
scenes. The prefab is automatically created when importing the plugin and is located at its root folder. It will handle
tasks like initialization and automatic ad loading.

It is advisable to add the EasyMobile prefab to the first scene in your game so that the modules have time to
initialize before you actually use them. Likewise, this will allow the automatic ad loading process to start soon
and the ads will be more likely available when needed.

e

' EasyMobile.prefab
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To add an EasyMobile instance to your scene, simply right-click in the Hierarchy window to open the context menu (as
you would when creating Unity built-in objects), then select Easy Mobile > EasyMobile Instance. Alternatively, you can
just drag the prefab to the Hierarchy window, only make sure to make it a root-level object (parentless).

Copy
Paste

Rename
Duplicate
Celete

Create Empty
3D Object

2D Object
Light

Audio

ul

Easy Mobile

AAY Y Y YY

EasyMobile Instance

Particle System Clip Player
Camera Clip Player {(UI)

A

If you're using Unity 5.6 or newer, you'll get a warning if you start an iOS or Android build without having added the
EasyMobile instance to one of your scenes.

EasyMobile Instance Missing

Mo root-level instance of the EasyMobile prefab was
found in the enabled scene(s). Please add one to the
first scene of your game for the plugin to function

properly.
——

Scripting

Easy Mobile API is written in C# and is put under the namespace EasyMobile. Therefore, you need to add the
following statement to the top of your script in order to access its APl methods.

using EasyMobile;
Easy Mobile's API is cross-platform so you can use the same codebase for both iOS and Android.

Testing Using the Demo App

Easy Mobile comes with a demo app that you can use to quickly test each module' s operation after configuring. The
demo app is contained in folder Assets/EasyMobile/Demo. To use the demo app, you need to add an instance of the
EasyMobile prefab to the DemoHome scene located in the Assets/EasyMobile/Demo/Scenes folder.



i Project E console B = Hierarchy | =
| crese - __@ 48 [ ]| crme-| G
(All Prefabs 4 Assets » EasyMobile » Main Camera
(All Scripts a i 1 » canvas
(1 EventSystem
VES Assets &4l Editor DemoHomeController
&5 Generated DemoUtils
&5 GUISkins SoundManager
ﬁ Mative
& Fonts &5 Packages
&5 Prefabs &5 Resources
Yﬁ Scenes ﬁ Script
&5 Modules
ﬁ Scripts
&5 scrollableList N
ﬁ Sprites
» 53 Editor
&5 Generated
» &5 GUISkins DemoHome scene
ﬁ Mative
b5 Packages v 8 |
&5 Resources b Om—

Using PlayMaker Actions

Starting from version 1.1.3, Easy Mobile is officially compatible with PlayMaker, with nearly 100 custom actions ready
to be used. You can install these actions from menu Window > Easy Mobile > Install PlayMaker Actions.

Easy Mobile's Demo App for PlayMaker

When installing the PlayMaker actions, a demo app will also be imported at
Assets/EasyMobile/Demo/PlayMakerDemo. This demo is a copy of our main demo app, rebuilt using PlayMaker
actions instead of C# scripts. You can take it as an example to get an insight into how Easy Mobile's PlayMaker
actions can be used in practice.

Apart from installing PlayMaker (obviously), you need to do a few more setup steps as described below, before
running this demo app.

Installing the Unity Ul add-on for PlayMaker

Our PlayMaker demo app uses the Unity Ul system, so you need to install the Unity Ul add-on for PlayMaker.

Adding the EasyMobile Prefab Instance

Similar to the main demo app discussed above, you need to add an instance of the Easy Mobile prefab to the
DemoHome_PlayMaker scene located in the Assets/EasyMobile/Demo/PlayMakerDemo folder.

Importing PlayMakerGlobals
The demo app uses global PlayMaker variables and events, so you need to import them before running the app.

If you project is new and doesn't have any PlayMakerGlobals (in the Assets/PlayMaker/Resources folder), simply copy
our Globals over by these steps:

e Double-click the PlayMakerGlobals.unitypackage in the Assets/EasyMobile/Demo/PlayMakerDemo folder.
e Locate the newly created file PlayMakerGlobals_ EXPORTED.asset right under the Assets folder.
e Rename the file to PlayMakerGlobals.asset and move it to the Assets/PlayMaker/Resources folder.

If you project already contains some global PlayMaker variables and events (a PlayMakerGlobals.asset file exists in
the folder Assets/PlayMaker/Resources), you can merge these with our demo's Globals using PlayMaker's Import
Globals tool: go to menu PlayMaker > Tools > Import Globals and select the PlayMakerGlobals.unitypackage in the
Assets/EasyMobile/Demo/PlayMakerDemo folder.


https://hutonggames.fogbugz.com/?W1192

Using Easy Mobile
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Advertising

The Advertising module helps you quickly setup and show ads in your games. Here're some highlights of this module:
o Supports multiple networks

o This module allows showing ads from most of top ad networks: AdColony, AdMob, Chartboost, Heyzap and
Unity Ads
o Even more networks can be used via AdMob or Heyzap mediation
e Using multiple networks in one game

o It's possible to use multiple ad neworks at the same time, e.g. use AdMob for banner ads, while using
Chartboost for interstitial ads and Unity Ads for rewarded ads
o Different configurations for different platforms are allowed, e.g. use Unity Ads for rewarded ads on Android,
while using Chartboost for that type of ads on iOS
e Automatic ad loading

o Ads will be fetched automatically in the background; new ad will be loaded if the last one was shown

The table below summarizes the ad types supported by Easy Mobile for each ad network.

Ad Network Banner Ad Interstitial Ad Rewarded Ad Mediation
AdColony @® @

AdMob O O ® ®
Chartboost ® O

Heyzap @® @® @® @®

Unity Ads @® ®



Module Configuration

Module Configuration

To use the Advertising module you must first enable it. Go to Window > Easy Mobile > Settings, select the Advertising

tab, then click the right-hand side toggle to enable and start configuring the module.

© inspector [ a |

| 7\ EM_Settings [ %
-

od § | M A

ADVERTISING

Advertising module provides easy-to-use AP, auto ad-loading feature and supports a wide
range of ad networks including AdMob, Chartboost, Heyzap and UnityAds.
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Setup Ad Networks

Setup Ad Networks

The Advertising module works with top mobile ad networks: AdMob, Chartboost, Heyzap and Unity Ads. To show ads
from a certain network you need to import its plugin (or enable the corresponding Unity service in case of Unity Ads).
Easy Mobile will automatically check for the availability of these plugins and prompt you to download and import them

if needed.

Only import plugins for the ad networks you use to not increase the build size unnecessarily.

| © inspector [ aes

" EM_Settings @ % |~
. Open

N T T . T Y

ADVERTISING c:u

ADMOB SETUP

‘ & Coogle Mobile Ads (AdMob) plugin not found. Please download and impaort it to show ads from AdMaob.

[ Download Google Mobile Ads Plugin

CHARTBOOST SETUP

‘ & Chartboost plugin not found. Please download and impaort it to show ads from Chartboost.

[ Download Chartboost Plugin

HEYZAP SETUP

‘ 43 Heyzap plugin not found. Please download and impaort it to show ads from Heyzap.

[ Download Heyzap Plugin

UNITY ADS SETUP

Services.

‘ Unity Ads service is disabled or not available for the current platform. To enable it go to Window =

AUTO AD-LOADING CONFIG

Auto-Load Default Ads )
Ad Checking Interval [10 |
Ad Loading Interval [20 |

DEFAULT AD METWORKS
¥ [i05] Default Ad Networks

Banner Ad Network | Ad Mab il
Interstitial Ad Network | Chartboost il
Rewarded Ad Network | Unity Ads =

¥ [Android] Default Ad Networks
Banner Ad Network | Heyzap il E}

A Note on using Heyzap
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Heyzap can serve ads from multiple other networks thanks to its mediation feature. To do so it requires 3rd-party
SDKs to be imported together with its own plugin. If you use Heyzap, you should not import the standalone-plugins of
other networks (AdColony, AdMob, Chartboost, etc.), to avoid potential conflicts. Instead, use them as mediated
networks under Heyzap and import their corresponding packages provided at the Heyzap download page.



AdColony

Create AdColony Apps and Zone Ids

To show ads from AdColony you need to create apps and ad zones in its clients portal. To access the clients portal,
create an account and login to AdColony page.

In the clients portal, select MONETIZATION tab, then select the Apps sub-tab and click the Setup New App button.

HOME MONETIZATION ADVERTISING SUPPORT B

Apps App Reports Download SDK
Q, Search Filter Back to Top &

Search by App Name Platform Date Range

Q All v - This Month + + Setup New App

In the opened page enter the required information for your new app, e.g. app name, platform and location. You can
also select the ad types that you would like to allow in your app. Hit Create when you're done, your app will be created
and you'll be redirected back to the Apps page. Select your newly created app to reveal its information, which looks

similar to the picture below. Note the AdColony App ID as we will use it later.

a Easy Mobile Demo (Unreleased)

Basic App Information

App Name Easy Mobile Demo (Unreleased)
Platform ’
Status 3 Zones
[
Price Free
Categories Casual,

AdColony App ID app770e6afad SN

Now your app is ready, the next step is to create ad zones for it. Click the Setup New Ad Zone at the bottom of the
app edit page to create a new ad zone.

In the Integration section, give your ad zone a name, optional notes and set its as active. Note the Zone ID as we'll
use it later.

The Zone ID will appear once you save your new ad zone.


https://www.adcolony.com/

Setup Ad Networks

Integration

Zone is active?

o Yes () No

Zone IDvz9494457a0750000000

Mame your ad zone

rewarded-ad

Special notes on this zone

Dedicated zone for rewarded ads

In the Creative Type section, select the Video option.

Creative Type

WARNING: Creative type for a zone cannot be change once the zone is created
+ Video

Display (In Testing)

In the Zone Type section, select Preroll/Interstitial if you want to use this zone for interstitial video ads. Otherwise,
select Value Exchange/V4VC to use it for rewarded ads.

Zone Type

~ Preroll/Interstitial @
© Value Exchange/V4VC @

VAVC Secret Key: vAve725c833860D

Client Side Only?

D Yes () No

Virtual Currency Name Daily Max Videos per User Reward Amaount

CfEd!tS 20 Must be greater than O 1 Must be greater than 0



In the Options section, you can set a daily cap or a session cap to limit the number of ads served to a user per day or
per session, respectively. In the Development section, you can choose to show test ads only (for debug purpose),
don't forget to disable this option when your app is released.

Options
Daily play cap Session play cap
0 0

0
Override App-Level Settings

Development
Show test ads only (for dev or debug)? — Yes ONo

Now your new ad zone is fully configured, click the Save button to save it. Repeat the process to create other ad
zones to suit your needs. Typically, you'd want to have 2 ad zones, one for interstitial ads and one for rewarded ads. If
you're targeting multiple platforms, create a new app for each platform, and for each app create the necessary ad

zZones.

Import AdColony Plugin

To have your Unity app work with AdColony you need to import the AdColony plugin for Unity. In the ADCOLONY
SETUP section of the Advertising module, click the Download AdColony Plugin button to to open the download page.
Download the plugin and import it to your project.

ADCOLONY SETUP

& AdColony plugin not found. Please download and import it to show ads from AdColony.

l Download AdColony Plugin

Configure AdColony

After importing the AdColony plugin, the ADCOLONY SETUP section will be updated as below.


https://github.com/AdColony/AdColony-Unity-SDK-3

ADCOLONY SETUP

':!;' AdColony plugin was imported.

Download AdColony Plugin

AdColony IDs

¥ iDs
App Id
Interstitial Ad Id
Rewarded Ad Id

¥ Android
App Id
Interstitial Ad Id
Rewarded Ad Id

Ad Settings

Show Rewarded Ad PrePopup [

Show Rewarded Ad PostPopup [

Ad Orientation | Ad Orientation All

[iOS] AdColony Ids: enter the app ID and zone IDs created in the AdColony clients portal for the iOS app
[Android] AdColony Ids: enter the app ID and zone IDs for the Android app

Show Rewarded Ad PrePopup: show the AdColony's default popup before a rewarded video starts
Show Rewarded Ad PostPopup: show the AdColony's default popup after a rewarded video has finished
Ad Orientation: select the orientation for the ads to match your app settings



AdMob

Import AdMob Plugin

To show ads from AdMob you need to import the Google Mobile Ads plugin. In the ADMOB SETUP section, click the
Download Google Mobile Ads Plugin button to to open the download page. Download the plugin and import it to your

project.

ADMOB SETUP

& Coogle Mobile Ads (AdMob) plugin not found. Please download and import it to show ads from AdMob.

l Download Google Mobile Ads Plugin

Configure AdMob

After importing the Google Mobile Ads plugin, the ADMOB SETUP section will be updated as below.

ADMOB SETUP

(_L_:l Google Mobile Ads (AdMob) plugin was imported.

l Download Google Mobile Ads Plugin

AdMob IDs
Y iDs
App Id
Banner Ad Id
Interstitial Ad Id
Rewarded Ad Id
¥ Android
App Id
Banner Ad Id
Interstitial Ad Id
Rewarded Ad Id

Ad Targeting

Gender

Tag For Child Directed Treatment
Extras

| Unspecified
| ¥as

Key

Test Mode

Enable Test Mode

¥ Test Device Ids
Size
Element O
Element 1

Enter AdMob IDs

Walue

First you need to enter the required app ID and ad unit IDs for each platform.


https://github.com/googleads/googleads-mobile-unity/releases

Setup Ad Networks

To find the App ID for your app follow the instructions here.

Note that you only need to provide the IDs of the ad units you want to use, e.g. if you only use AdMob banner
ad you can leave the interstitial ad and rewarded ad IDs empty.

If you're not familiar with AdMob, follow the instructions here to create ad units and obtain the ad IDs; an ad ID
should have the form of ca-app-pub-0664570763252260XXXXXXXXXXX.

Ad Targeting Settings

You can provide targeting information for your app in the Ad Targeting sub-section. These settings will be applied to
all AdMob ad requests in your app. You can learn more about AdMob ad targeting here.

e Gender.: the target user gender

e Tag For Child Directed Treatment: indicates whether you want Google to treat your content as child-directed
when you make an ad request for the purposes of Children's Online Privacy Protection Act (COPPA)

e Extras: extra settings in form of key value pairs, e.g. for setting "max_ad_content_rating"

Using AdMob with the Designed for Families program

According to this article, apps that join in to Google Play's Designed for Families program can fall into two
categories:

e Primarily child-directed apps: if your app is admitted to the program as a primarily child-directed app,
"AdMob will automatically begin serving Designed for Families-compliant ads for all ad requests coming
from the app", which means you don't need to specify the child directed setting in your app.

o Mixed-audience apps: if your app targets both child and adult audiences, you need to set the extra key
"is_designed_for_families" to frue and tag your app for child-directed treatment. You can do that in Easy
Mobile settings as below.

Ad Targeting

GCender | Unspecified =

Tag For Child Directed Treatment | ¥es |

Extras D
Key lis_designed_for_families | value [true |

Overriding AdMob targeting settings in script

You can override AdMob targeting settings in script by setting the property
EM_Settings.Advertising.AdMobTargeting. All subsequent ad requests will be sent with the new settings.

Using AdMob Test Mode

To enable AdMob's test mode, simply check the Enable Test Mode option and enter the IDs of your testing devices
into the Test Device Ids array.

Test Mode
Enable Test Mode 4
¥ Test Device Ids
Size [2 |

Element 0 [219436D312DE3320727940 |
Element 1 le29cdog9g7a6f29aesdd7fs. |

You can find the ID of your test device by building and running the Easy Mobile demo app on that device.

Remember to add the EasyMobile prefab to the DemoHome scene before starting the build.

Android device ID

24


https://support.google.com/admob/answer/6232340?hl=en
https://support.google.com/admob/answer/2773509
https://developers.google.com/admob/unity/targeting
https://support.google.com/admob/answer/6223431?hl=en
https://developer.android.com/distribute/googleplay/families/about.html

Setup Ad Networks

e In Unity, build the Easy Mobile demo app for Android platform
e Install and run the demo app on your testing device
e Open Terminal (Mac) or Cmd (Windows) and type in

adb logcat -s Ads

(if you're on Windows, you may need to add the Android SDK path to the Windows System PATH)

e In the demo app, select ADVERTISING and then click the SHOW BANNER AD button
e Observe the output logcat in the Terminal/Cmd and locate a line similar to the one in the following image,

the value between the double quotes is your device ID

I Ads : Starting ad request.
I Ads : Use AdRequest.Builder.addTestDevice("219436D312DE3320727040000") to get test ads on this device.
iOS device ID

e In Unity, build the Easy Mobile demo app for iOS platform
e Open the generated project in Xcode and run it on your testing device
e Type 'google’ into the filter box of the Xcode Console, and find your device ID between the double quotes

as highlighted in the following image

| @ & | B easymobile

| 2817-85-84 13:53:33.613316+870@ easymobi
| this device, call: request.testDevices =
| GoogleMobileAds. Api.InterstitialGoogleMol
| idReceiveAdCallback({IntPtr)

| GoogleMobileAds. Api.RewardBasedVideoAd: <RewardBasedVideoAd>m__1(0bject,

| AdFailedToLoadEventArgs)

| GoogleMobileAds.i05.RewardBasedVideoAdClient:RewardBasedVideoAdDidFailToReceiveAdwit
| hErrorCallback(IntPtr, String)

| GoogleMobileAds.Api.RewardBasedVideoAd: <RewardBasedVideoAd>m__8(0Object, EventArgs)

| GoogleMobileAds.i05.RewardBasedVideoAdClient :RewardBasedVideoAdDidReceiveAdCallback(

| IntPtr)
All Qutput 2 () google ol o OO

@[ @"e29cd98987a6F29aeSdd7 FElD" 1;

[i0OS] CocoaPods Requirement

The Google Mobile Ads plugin for Unity employs CocoaPods to automatically import the necessary frameworks to the

generated Xcode project when an iOS build is performed in Unity. Therefore you need to install CocoaPods to your
Mac: please go to https://cocoapods.org/ for install instructions, as well as for more information about CocoaPods.
Note that you only need to install CocoaPods, everything else will be done automatically by the Google Mobile Ads
plugin.
When building for iOS in Unity, CocoaPods will automatically create an Xcode workspace (with .xcworkspace
extension) in the generated Xcode project. You should always open this workspace instead of the normal

project file (with .xcodeproj extension).

25


https://www.howtogeek.com/118594/how-to-edit-your-system-path-for-easy-command-line-access/
https://cocoapods.org/

Setup Ad Networks

v

[ build
BE Classes
Bl Data
Info.plist
B LaunchScreen-iPad.png
LaunchScreen-iPad.xib
= LaunchScreen-iPhone.xib
B LaunchScreen-iPhonelLandscape.png
B LaunchScreen-iPhonePortrait.png
» [ Libraries
B MapFileParser
MapFileFarser.sh
Podfile
Podfile.lock
7 Pods
[ Unity-iPhone
[ Unity-iPhone Tests
5 Unity-iPhone. xcodeproj
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Chartboost

Import Chartboost Plugin

To show ads from Chartboost you need to import the Chartboost plugin for Unity. In the CHARTBOOST SETUP

section, click the Download Chartboost Plugin button to open the download page. Download the plugin and import it to

your project.

CHARTBOOST SETUP

‘ A Chartboost plugin not found. Please download and impaort it to show ads from Chartboost.

| DownloadChartboostPlugin |

Configure Chartboost

After importing Chartboost plugin, the CHARTBOOST SETUP section will be updated as below.

CHARTBOOST SETUP

@ Chartboost plugin was imported.

| DownloadChartboostPlugin |
| sewpChartboost |

Click the Setup Chartboost button to open Chartboost' s settings tool.

(@ nspector [ e
D ChartboostSettings :
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https://answers.chartboost.com/hc/en-us/articles/200780379

Provide the App IDs and App Signatures for your targeted platforms. Remember to click the Setup Android SDK
button if you're building for Android.

To obtain the App Id and App Signature you need to add your app to the Chartboost dashboard. If you're not
familiar with the process please follow the instructions here.

After adding the app, go to APP SETTINGS > Basic Settings to find its App ID and App Signature.

Chartboost 4 DASHEOARD MARKETPLACE HELP H151 | Squishbear v

Buster's Boost R
E - App Settings |

App Nickname

Buster's Boost lE
Basic Settings D

App Bundie 1D (2

App ID
com.chartboost.apollo : 5689b4418838092b63cf9410

App Orientation * App Signature
Portrait Landscape edabc1cedad0318edd64a4584859b534c985373c

Please select a default orlentation for this app: Official Name

Buster's Boost

READ_PHONE_STATE permission on Android

The Chartboost SDK includes the READ_PHONE_STATE permission on Android, to "handle video playback when
interrupted by a call", as stated in its manifest. READ_PHONE_STATE permission requires your app to have a
privacy policy when uploaded to Google Play. Since this permission is not mandatory to run the Chartboost SDK, you
can safely remove it if you are not ready to provide the required privacy policy. To remove the permission, open the
AndroidManifest.xml file located at Assets/Plugins/Android/ChartboostSDK folder, then delete the corresponding line
(or comment it out as below).

<!-- Exclude the READ_PHONE_STATE permission because it requires a privacy policy -->
<!-- <uses-permission android:name="android.permission.android.permission.READ_PHONE_STATE" /> -->

Testing Notes

Please note that to show ads from Chartboost you need to either create a publishing campaign or enable the Test
Mode for your app.

e To create a publishing campaign follow the instructions here
e To enable Test Mode follow the instruction here


https://answers.chartboost.com/hc/en-us/articles/200797729-Adding-Your-First-App-and-Campaign-
https://answers.chartboost.com/hc/en-us/articles/204930539-Creating-a-Publishing-Campaign
https://answers.chartboost.com/hc/en-us/articles/200780549-Test-Mode

Heyzap

As mentioned earlier, if you use Heyzap's mediation with other networks (AdColony, AdMob, Chartboost, etc.),
you should not import the standalone-plugins of those networks, to avoid potential conflicts. Instead, import their
corresponding packages provided at the Heyzap download page.

Import Heyzap Plugin

To show ads from Heyzap you need to import the Heyzap plugin for Unity. In the HEYZAP SETUP section, click the
Download Heyzap Plugin button to open the download page.

HEYZAP SETUP

‘ & Heyzap plugin not found. Please download and impaort it to show ads from Heyzap. ‘

[ Download Heyzap Plugin ]

In the download page select your preferred networks to use with Heyzap mediation. The Heyzap dynamic
documentation will update automatically to reflect your selections.

Network Selection:

heyZap AdColony v AdMob

v/ ApplLovin Chartboost v Facebook
HyprMX InMobi Tapjoy
v' UnityAds v’ Vungle

Follow the instructions provided by Heyzap to download and import its plugin as well as other required 3rd-party
plugins. Also go through the Integration Notes section below to avoid problems that may occur during the integration
of 3rd-party networks.

If you haven't already, use Heyzap's Integration Wizard to setup the 3rd-party networks to use with mediation.

Configure Heyzap

After importing Heyzap plugin, the HEYZAP SETUP section will be updated as below. You can now enter your
publisher Id to the Heyzap Publisher Id field.


https://answers.chartboost.com/hc/en-us/articles/200780379
https://developers.heyzap.com/integration_wizard

HEYZAP SETUP

' r'\

:*-'.;’: Heyzap plugin was imported.

Download Heyzap Plugin

Heyzap Publisher Id

Show Heyzap Test suite

Heyzap Mediation Test Suite

The Heyzap plugin comes with a convenient Test Suite that you can use to test each of the networks you selected for
mediation. To use this Test Suite, simply check the Show Heyzap Test Suite option in the HEYZAP SETUP section.

HEYZAP SETUP

' r'\

:*-'.;’: Heyzap plugin was imported.

Download Heyzap Plugin

Heyzap Publisher Id

Show Heyzap Test Suite

Below is the Test Suite interface on iOS.

iPhone 6 - iPhone 6 /i0S 9.3 (13£230)

iPhone 6 - iPhone 6 /i0S 9.3 (13£230)

Done Mediated Networks

Fyber Version 8.5.0

Successfully Integrated

AdColony

AppLovin

Facebook Audience Network
UnityAds

Bad / Missing Credentials
AdMob

No SDK Detected
Chartboost

HyprMx

Inmobi

Vungle

Integration Notes

< Mediated Networks UnityAds

| interstitia Rewarded

Show Ad —

UnityAds 1.5.5-r2
Supported ad formats: Interstitial Rewarded
A rewarded ad available

iPhone 6 - iPhone 6 /0S 9.3 (13£230)

You can skip this video in 1 seconds

This video ends in 21 seconds.

This section discusses some notes that you should take when using Heyzap mediation with various other networks.

Facebook Audience Network (Android-specific)

The Facebook Audience Network package contains an android-support-v4.jar _file under Assets/Plugins/Android
folder. If you project already contains a support-v4-xx.x.x.aar file under that same folder, feel free to remove (or
exclude it when importing) the jar file or it will cause the "Unable to convert dex..." error when building due to duplicate

libraries.



AppLovin (Android-specific)

As instructed in the Heyzap documentation, you need to add the AppLovin SDK key to its AndroidManifest.xml file
located at Assets/Plugins/Android/AppLovin folder. Simply add the following line inside the <application> tag in the
manifest, replacing YOUR_SDK_KEY with your actual AppLovin SDK key.

<meta-data android:name="applovin.sdk.key" android:value="YOUR_SDK_KEY"/>

This manifest also includes the READ_PHONE_STATE permission, which requires your app to have a privacy policy
when uploaded to Google Play. This permission is not mandatory to run the AppLovin SDK, therefore you can safely
remove it if you are not ready to provide the required privacy policy. To remove the permission, simply delete the
corresponding line from the manifest or comment it out as below.

<!-- Exclude the READ_PHONE_STATE permission because it requires a privacy policy -->
<!-- <uses-permission android:name="android.permission.READ_PHONE_STATE" /> -->

The minSdkVersion Problem (Android-specific)

The current Heyzap SDK requires a minSdkVersion of 10, while some other 3rd-party plugins may require a version of
11 or above. If you get a build error including this line

Unable to merge android manifests...

and this line

Main manifest has <uses-sdk android:minSdkVersion='x'> but library uses minSdkVersion='y'

where x <y, it means you need to increase the minSdkVersion of the app. To do so go to Edit > Project Settings >
Player, then select the Android settings tab and increase its Minimum API Level to the required one (which is 'y in this
example).
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Settings for Android

Resolution and Presentation

Icon

Splash Image

Other Settings
Rendering

Rendering Path* | Forward

Auto Graphics AP
Multithreaded Rendering®
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Dynamic Batching

GPU Skinning™

Wirtual Reality Supported

O0EEOE

Identification

Bundle Identifier |co m.sglib.easymobile

WVersion® | 1.0

Bundle Version Code 1

I Minimum AP| Level Android 3.0 "Honeycomb® (AP level 11}

Configuration

Scripting Backend | Mono2x s
Disable HW Statistics -
Device Filter | FAT (ARMv7 +286) K
Install Location | Prefer External i
Internet Access | Auto o
Write Access | Internal Only &
Android TV Compatibility [
Android Game [

Android Gamepad Support Leve| Works with D-pad
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Optimization

Api Compatibility Level | .MET 2.0 Subset
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=
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32



Setup Ad Networks

Unity Ads

Enable Unity Ads Service

To use Unity Ads service, you must first set up your project for Unity Services.

To show ads from Unity Ads you need to enable the corresponding service. Easy Mobile will automatically check for
the service's availability and warn you to enable it if needed. Below is the UNITY ADS SETUP section when Unity Ads
is not enabled.

UNITY ADS SETUP

Unity Ads service is disabled or not available for the current platform. To enable it go to
Window » Services.

To enable Unity Ads switch the platform to iOS or Android, then go to Window > Services and select the Ads tab.

SERVICES

2 Ads

4 Analytics

& Cloud Build

&% Multiplayer
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https://docs.unity3d.com/Manual/SettingUpProjectServices.html

Setup Ad Networks

In the opened configuration window, click the toggle at the right-hand side to enable Unity Ads service. You may need
to answer a few questions about your game.

i0s | Android

The UNITY ADS SETUP section will be updated after Unity Ads has been enabled.

UNITY ADS SETUP

@ Unity Ads service is enabled.

Testing Notes

It is advisable to enable the test mode of Unity Ads during development. This will ensure there's always an ad
returned whenever requested. To enable test mode simple check the Enable test mode option within the Ads
configuration window.

Remember to disable this test mode when creating your release build.
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Automatic Ad Loading

Automatic ad loading is a feature of the Advertising module. It regularly checks for the availability of default ads, and
performs loading if needed, to make sure that ads are always ready when they need to be shown. You can configure
this feature in the AUTO AD-LOADING CONFIG section.

Default ads are ads loaded from default networks, see Default Ad Networks section.

AUTO AD-LOADING CONFIG

Auto-Load Default Ads [+
Ad Checking Interval 10
Ad Loading Interval 20

e Auto-Load Default Ads: uncheck this to disable automatic ad loading feature, you can load ads manually from
script, see Scripting section for instructions on this

e Ad Checking Interval: change this value to determine how frequently the module should perform ads availability
check, the smaller the more frequently

e Ad Loading Interval: the minimum time between two ad loading requests



Default Ad Networks

Default Ad Networks

You can select default ad networks for each platform in the DEFAULT AD NETWORKS section. You can have
different networks for different ad types and different selections for different platforms. If you don't want to use a
certain type of ad, simply set its network to None.

DEFAULT AD METWORKS
¥ [i05] Default Ad Networks

Banner Ad Network | Ad Maob =

Interstitial Ad Network | Chartboost =

Rewarded Ad Network | Unity Ads =
¥ [Android)] Default Ad Metworks

Banner Ad Network | Ad Maob =

Interstitial Ad Network | Ad Mab ™=

Rewarded Ad Network [ unity Ads : |

& Default ad network AdMob has no SDE. Flease import its plugin.

& Default ad network Chartboost has no SDE. Flease import its plugin.

& Default ad network UnityAds has no SDK. Please import its plugin.

Pay attention to the warnings and import the required plugins if you haven't already.



Scripting
This section provides a guide to work with the Advertising API using the default ad networks configured in the module
settings.

You can access the Advertising module API via the Advertising class under the EasyMobile namespace.

Banner Ads

To show a banner ad you need to specify its position using the BannerAdPosition enum. The banner will be displayed
once it is loaded.

// Show banner ad
Advertising.ShowBannerAd(BannerAdPosition.Bottom);

To hide the current banner ad (it can be shown again later):

// Hide banner ad
Advertising.HideBannerAd();

To destroy the current banner ad (a new one will be created on the next banner ad showing):

// Destroy banner ad
Advertising.DestroyBannerAd();

Interstitial Ads

The method to show an interstial ad requires it to be already loaded. Therefore you should check for the ad's
availability before showing it.

// Check if interstitial ad is ready
bool isReady = Advertising.IsInterstitialAdReady();

// Show it if it's ready
if (isReady)

{
Advertising.ShowInterstitialAd();

An InterstitialAdCompleted event will be fired whenever an interstitial ad is closed. You can listen to this event to take
appropriate actions, e.g. resume the game.

// Subscribe to the event
void OnEnable()

{
Advertising.InterstitialAdCompleted += InterstitialAdCompletedHandler;

// The event handler
void InterstitialAdCompletedHandler(InterstitialAdNetwork network, AdLocation location)

{

Debug.Log("Interstitial ad has been closed.");

// Unsubscribe



void OnDisable()
{

Advertising.InterstitialAdCompleted -= InterstitialAdCompletedHandler;

Rewarded Ads

The method to show a rewarded ad requires it to be already loaded. Therefore you should check for the ad's

availability before showing it.

// Check if rewarded ad is ready
bool isReady = Advertising.IsRewardedAdReady();

// Show it if it's ready
if (isReady)
{
Advertising.ShowRewardedAd();

A RewardedAdCompleted event will be fired whenever a rewarded ad has completed. You should listen to this event

to reward the user for watching the ad. Otherwise, a RewardedAdSkipped event will be fired if the ad is skipped

before finishing (and the user therefore is not entitled to the reward).

// Subscribe to rewarded ad events

void OnEnable()

{
Advertising.RewardedAdCompleted += RewardedAdCompletedHandler;
Advertising.RewardedAdSkipped += RewardedAdSkippedHandler;

// Unsubscribe events
void OnDisable()

{
Advertising.RewardedAdCompleted -= RewardedAdCompletedHandler;

Advertising.RewardedAdSkipped -= RewardedAdSkippedHandler;

// Event handler called when a rewarded ad has completed

void RewardedAdCompletedHandler (RewardedAdNetwork network, AdLocation location)

{

Debug.Log("Rewarded ad has completed. The user should be rewarded now.");

// Event handler called when a rewarded ad has been skipped

void RewardedAdSkippedHandler (RewardedAdNetwork network, AdLocation location)

{

Debug.Log("Rewarded ad was skipped. The user should NOT be rewarded.");

Remove Ads

In some cases you need to remove/stop showing ads in your game, e.g. when the user purchases the "Remove Ads

product. To remove ads:

// Remove ads permanently
Advertising.RemoveAds();

The RemoveAds method will destroy the banner ad if one is being shown, and prevent future ads from being loaded
and shown except rewarded ads, since they are unobtrusive and only shown at the user discretion.



Note that the RemoveAds method uses Unity's PlayerPrefs to store the ad removal status with no
encryption/scrambling.

An AdsRemoved event will be fired after ads have been removed. You can listen to this event and take appropriate
actions, e.g update the UI.

// Subscribe to the event
void OnEnable()
{

Advertising.AdsRemoved += AdsRemovedHandler;

}

// The event handler
void AdsRemovedHandler ()

{

Debug.Log("Ads were removed.");

// Unsubscribe

Advertising.AdsRemoved -= AdsRemovedHandler;
}

You can also check at any time if ads were removed or not.

// Determine if ads were removed
bool isRemoved = Advertising.IsAdRemoved();

Finally, you can also revoke the ad removing status and allow ads to be shown again.

// Revoke ad removing status and allow showing ads again
Advertising.ResetRemoveAds();

Manual Ad Loading

Normally you don't need to worry about loading ads if the automatic ad loading feature is enabled (see Configure
Advertising Module section). Otherwise, if you choose to disable this feature, you can load ads manually from script.

It is advisable to load an ad as far in advance of showing it as possible to allow time for the ad to be loaded.

To load an interstitial ad:

// Load an interstitial ad
Advertising.LoadInterstitialAd();

To load a rewarded ad:

// Load a rewarded ad
Advertising.LoadRewardedAd();

Working with Non-Default Ad Networks

Beside the default ad networks, you can also load and show ads from non-default networks, thus creating a more
sophisticated ad network combination in your app. Note that each method to load or show ad always has a variant
that allows you to specify the target ad network explicitly. For example there're 2 variants of the LoadInterstitialAd
method. One takes no argument and loads the default interstitial ad. The other loads an interstitial ad from a network
specified explicitly. If you have AdMob as the default interstitial ad network, you can load and show interstitial ad from
the non-default AdColony like below.



The Automatic Ad Loading feature won't handle non-default ads, so you need to load ads manually before
showing them.

// This method shows an interstitial ad from the default network (i.e. AdMob in this example).
// Default ads are loaded automatically so you won't need to load them manually,
// unless Automatic Ad Loading is disabled.
if (Advertising.IsInterstitialAdReady())
Advertising.ShowInterstitialAd();

// Non-default ads are not loaded automatically, so you need to load them manually before they can be shown.
// You should do this early to allow sufficient time for an ad to be loaded before showing it.

// In this example, we'll load and show an interstitial ad from the non-default network AdColony.
Advertising.LoadInterstitialAd(InterstitialAdNetwork.AdColony, AdLocation.Default);

// Checks if an AdColony interstitial ad is ready and shows it.
if (Advertising.IsInterstitialAdReady(InterstitialAdNetwork.AdColony, AdLocation.Default))
Advertising.ShowInterstitialAd(InterstitialAdNetwork.AdColony, AdLocation.Default);



PlayMaker Actions

PlayMaker Actions
The PlayMaker actions of the Advertising module are group in the category Easy Mobile - Advertising in the
PlayMaker's Action Browser.

Please refer to the AdvertisingDemo_PlayMaker scene in folder
Assets/EasyMobile/Demo/PlayMakerDemo/Modules for an example on how these actions can be used.

Easy Mobile - Advertising

Advertising_Destroy Banner Ad
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PlayMaker Actions
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Game Services

The Game Services module helps you quickly implement leaderboards and achievements for your game. It works with
the Game Center network on iOS and Google Play Games services on Android. Here're some highlights of this

module:

e Leverages official plugins

o This module is built on top of Unity's GameCenterPlatform on iOS and Google Play Games plugin on Android
o GameCenterPlatform is one part of the UnityEngine itself while the other is the official Google Play Games
plugin for Unity, so reliability and compatibility can be expected
o Easy management of leaderboards and achievements

o Easy Mobile's custom editor features a friendly interface that help you easily add, edit or remove

leaderboards and achievements


https://github.com/playgameservices/play-games-plugin-for-unity

Module Configuration

Module Configuration

To use the Game Services module you must first enable it. Go to Window > Easy Mobile > Settings, select the Game

Services tab, then click the right-hand side toggle to enable and start configuring the module.

L] Inspector
7 EM_Settings [

#

o | S | = | a

GAME SERVICES

|
— |
i

achievements for your game. It provides a cross-platform APl that works with the Game

Came Services module helps you quickly implement services like leaderboards and
Center network on 05 and Google Play Games services on Android.
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Android-Specific Setup

Import Google Play Games plugin for Unity

As stated earlier, this module is built on top of Google Play Games Plugin on Android. Therefore you need to import it
to use the module on this platform. Easy Mobile will automatically detect the availability of the plugin and prompt you
to import it if needed. Below is the module settings interface on Android platform when Google Play Games plugin
hasn't been imported.

GAME SERVICES q

Coogle Flay Games plugin is required. Flease download and impaort it to use this module on
Android.

l Download Google Play Games Plugin

Click the Download Google Play Games Plugin button to open the download page, then download the package and
import it to your project. Once the import completes the module interface will be updated and ready for you to start
with the configuration.

GAME SERVICES (

'i_rq_:l Coogle Flay Games plugin is imported and ready to use.

l Download Google Play Games Plugin

GOOGLE PLAY GAMES SETUP
GPGS Debug Log [

Since we're not using Google Play Games plugin on iOS, the NO_GPGS symbol will be defined for i0OS
platform automatically after the plugin is imported in order to disable it.

Setup Google Play Games

To setup Google Play Games plugin, you need to obtain the game resources from the Google Play Developer
Console.

The game resources are available after you configured your game on the Google Play Developer Console. If
you're not familiar with the process, please follow the instructions on creating a client ID, as well as
leaderboards and achievements.

To get the game resources, login to your Google Play Developer Console, select Game services tabs then select your
game. Next go to the Achievements tab and click on the Get Resources label at the bottom of the list.


https://github.com/playgameservices/play-games-plugin-for-unity
https://developers.google.com/games/services/console/enabling
https://developers.google.com/games/services/common/concepts/leaderboards
https://developers.google.com/games/services/common/concepts/achievements

Android-Specific Setup

o Minimal
AT
b
£ e STATH

§ o MAME ng f— LBLOCHED % ETATUS
Reverua dotads TOTAL #/ TIME &
Demag npiics 1 g Welosmo C rpm—at AT 8 - & [Ready o lest
Events varwof Toisl peints: 5
Tima sofies

Vil P 85 o 82 ka4 oo behiswierents I publsh yous gl

Foaturs analytcs

ey Laiurmy il BECU IMpamesnSng Schrnmants in th dewsepsd Socumnnin

Engagamisnt dotads

e = Click this to get
i ° the resources

Copy all the xml content from the Android tab.

Ready to tesl ¥

EXPORT RESOURCES

Android  Objective-C  Javascript Text

~ <7xml version="1.0" encoding="utf-8"?>

<l--

Google Play game services |Ds.

Save this file as res/values/games-ids.xml in your project.

=

<TesoUrcess
<string name="app_id">41 152255531 </string>
<siring name="package_name"=com. geeste epmmminimal</string=
<string name="achievemeant_welcome">Cgllfsil == Q</string>

</resources=>
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Go back to Unity, in the [ANDROID] GOOGLE PLAY GAMES SETUP section, paste the obtained xml resouces into
the Android XML Resources area, then click Setup Google Play Games.

[ANDROID] GOOGLE PLAY GAMES SETUP
GPGS Debug Log =

i Paste in the Android XML Resources from the Play Console and hit the Setup button.

Android XML Resources

| <7xml version="1.0" encoding="utf-87>
[<l--
Google Play game services IDs.
Save this file as res/values fgames-ids.«xml in your project.
-
<rESOUFCEs >
<string name="app_id">6549 L (string =
<string name="package_name">com.sglib.easymobile< /string>
<string name="achievement_sample_achievement_1">CgklgrCKZ4cTEAIQAQ
<string name="achievement_sample_achievement_2">CagklgrCKZ4cTEAIQAw

<string name="achievement_sample_achievement_3">CgklgrCK24cTEAIQBA< ¥
4 W 4

|I Setup Google Play Games

(—

After the setup has completed, a new file named EM_GPGSIds will be created at Assets/EasyMobile/Generated. This
file contains the constants of the IDs of all the leaderboards and achievements in your Android game.

Enable Google Play Games Debug Log

To enable Google Play Games debug log, simply check the GPGS Debug Log option in the [ANDROID] GOOGLE
PLAY GAMES SETUP section.

[ANDROID] GOOGLE PLAY GAMES SETUP
[cPcs Debug Log M |

| Paste in the Android XML Resources from the Flay Console and hit the Setup button,

Android XML Resources
Google Play game services |1Ds.

|

Save this file as res/values fgames-ids.xml in your project. ﬁ
-
<rBSOUFCEs >

<string name="app_id">6549 < fstring =

<string name="package_name">com.sglib.easymobile< /string>

<string name="achievement_sample_achievement_1">CagklgrCK24cTEAIQAQ <
<string name="achievement_sample_achievement_2"“>CgklgrCK24cTEAIQAw=<
<string name="achievement_sample_achievement_3">CgklgrCKZ4cTEAIQBA <
<string name="achievement_sample_achievement_4">CgklgrCK24cTEAIQBQ < _ |
<string name="achievement_sample_achievement_5">CoklgrCKZ4cTEAIQBg < *

A —— P

I Setup Google Play Games ]




Auto Initialization

Auto initialization is a feature of the Game Services module that initializes the service automatically when the module
starts. Initialization is required before any other actions can be done, e.g. reporting scores.

During the initialization, the system will try to authenticate the user by presenting a login popup.

e OniOS, this popup will show up when the app gets focus (brought to foreground) for the first 3 times. If the user
refuses to login all these 3 times, the OS will ignore subsequent authentication calls and stop presenting the login
popup (to avoid disturbing the user). Otherwise, if the user has logged in successfully, future authentication will
take place silently with no login popup presented.

e On Android, we employ a similar approach but you can configure the maximum number of authentication
requests before ignoring subsequent ones.

You can configure the auto initialization feature within the AUTO-INIT CONFIG section.
AUTO-INIT CONFIG
Auto Init [+
Auto Init Delay 0
[Android] Max Login Requests |3

e Auto Init: uncheck this option to disable the auto initialization feature, you can start the initialization manually from
script (see the Scripting section)

e Auto Init Delay: how long after the module start that the initialization should take place

e [Android] Max Login Requests: maximum number of authentication requests allowed on Android, before ignoring
subsequent ones (in case the user refuses to login)

"Module start" refers to the moment the Start method of the module's associated MonoBehavior (attached to the
EasyMobile prefab) runs.



Leaderboards & Achievements

This section provides a guide to manage leaderboards and managements for your game.

Before You Begin

It is assumed that you already configured your game for the targeted gaming networks, i.e. Game Center and
Google Play Games. If you're not familiar with the process, here're some useful links:

e Configure for Google Play Games (Android)

o Creating a Client ID for you game
o Adding leaderboards
o Adding achievements

e Configure for Game Center (iOS)
o Adding leaderboards and achievements in iTunes Connect

In the LEADERBOARD SETUP and ACHIEVEMENT SETUP you can add, edit or remove leaderboards and
achievements.

Add a New Leaderboard or Achievement

To add a new leaderboard click the Add New Leaderboard button (or Add New Achievement button in case of an

achievement).

LEADERBOARD SETUP
| Mo Leaderboard added.

Add New Leaderboard

A new empty leaderboard (or achievement) will be added.

Mame i |
i0S Id [ |
|

Bt Lenden bne
—

Android Id [None] ¢ |

Fill in the required information of the leaderboard (or achievement):

e Name: the name of this leaderboard (or achievement), this name can be used when reporting scores to this
leaderboard (or unlocking this achievement)

e jOS Id: the ID of this leaderboard (or achievement) as declared in iTunes Connect

e Android Id: the ID of this leaderboard (or achievement) as declared in Google Play Developer Console

Google Play Games' leaderboards and achievements have generated IDs which can be difficult to memorize
and cumbersome to copy-and-paste, especially if there are many of them. Thankfully, when you setup Google
Play Games, the constants of these IDs are generated automatically (remember that EM_GPGSIds file?),
allowing Easy Mobile to show a nice dropdown of all defined leaderboard and achievement IDs for you to

choose from.


https://developers.google.com/games/services/console/enabling
https://developers.google.com/games/services/common/concepts/leaderboards
https://developers.google.com/games/services/common/concepts/achievements
https://developer.apple.com/library/content/documentation/NetworkingInternet/Conceptual/GameKit_Guide/Achievements/Achievements.html

Sample Leaderboard

|

Mame [Sample Leaderboard - | i
i05 Id com.easymobile.sample_leaderboard |
Android Id ¥ [Mone] .

achievement_sample_achievement_10
|
achievement_sample_achievement_]

ACHIEVEMENT SETUP achievement_sample_achievement_2

1 Achievemeants achievement_sample_achievement_3
achievement_sample_achievement_4
[ achievement_sample_achievement_5
achievement_sample_achiev